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The SwitchBlade x3112 is a 12 Slot Access Edge Chassis Switch primarily 
targeted for service provider fiber access networks, and equally at home 
at the enterprise network edge and the data center. The switch was 
designed to deliver high availability, maximum performance with wire 
speed non-blocking backplane performance, and high port count.

FTTx Service Provider Applications
The AT-SBx3112 is a versatile carrier-
class FTTx platform for delivering Gigabit 
services to residential, Multi-Dwelling Unit 
(MDU) and business customers in the last 
mile. It features redundant power supplies, 
controllers and WAN ports to ensure 
reliability standards in carrier networks are 
met, along with powerful sub-50 millisecond 
failover protection using EPSR ring for link 
level protection. The AT-SBx3112 is available 
with either AC or DC power options.

As a FTTx platform, the AT-SBx3112 can 
support a maximum of 240 ports per chassis 
using 24-port 100/1000Mbps SFP-based line 
cards (AT-SBx31GS24). It can also support 
redundant 10G uplinks using 4-port XFP 
based line cards with EPSR (AT-SBx31XZ4). 
The x3112 can act as an aggregation hub for 
last mile FTTx applications using 10G line 
cards. It features 40 Gigabit non-blocking 
throughput to each slot, thus providing a 
maximum level of performance for FTTx 
services, both 1G and 10G. Coupled 
with ultra-fast 200G switch controllers, 
FTTx services can operate at wire speed 
connectivity.

An evolution of our tried and tested iMAP 
(integrated Multi-service Access Platform) 
carrier-grade platform, the AT-SBX3112 
delivers true IP Triple Play services such 
as IPTV, VoIP. Tiered High Speed Internet 
Access (HSIA) and other cloud based 
services such as Over-the-Top Video, 
remote storage and backup, and cloud 
computing.

Securing the Network Edge
To ensure the protection of the data, it is 
important to control access to the network. 
Protocols such as IEEE 802.1x authentication 
guarantee that only known users are 
connected to the network. Unknown users 
who physically connect can be isolated to a 
pre-determined part of the network, offering 
guests such benefits as Internet access while 
ensuring the integrity of private network data.

Secure Differentiation
QoS schemes for x3112 access solutions 
are designed to ensure that application 
performance and availability are not 
impacted with network growth. Features 
such as IEEE 802.1p/Q enable tiered 
data services for residential, business and 
enterprise users or prioritize real-time 
applications such as IP phones and IP 
cameras.

Environmentally Friendly  
ECO-Switch
In keeping with our commitment to 
environmentally friendly processes and 
products, the x3112 is designed to reduce 
power consumption and minimize hazardous 
waste. Features include the use of high 
efficiency power supplies 
and low power chip sets. 
The switches also include 
an ECO-Switch button 
on the front panel allowing conservation of 
additional power by turning off all diagnostic 
LED indicators when they are not required.

The raw performance combined with high 
availability of the AT-SBx3112 also allows 
it to be deployed as both end-of-row and 
aggregation in data center applications, and 
in campus applications as the ultimate in 
network edge connectivity.

High-Availability Architecture
The x3112 is designed to deliver 99.999% 
reliability, while offering high availability with 
sub-millisecond hitless failover for mission-
critical applications where uptime is essential 
such as data centers, hospitality, government, 
and financial institutions.

Dual Redundant Management/Fabric 
Modules inter-connecting through 
redundant paths to the line cards over a 
passive backplane, and Dual Redundant 
Power Options, ensures maximum system 
up-time. Power is delivered via up to two 
System Power Supplies, and two Power-
over-Ethernet Supplies to ensure continual 
operation.

Power over Ethernet Plus (PoE+)
The x3112 supports IEEE 802.3at PoE+ 
(30W) to enable customers to future-
proof their network. PoE+ provides greater 
power for applications such as IP surveillance 
cameras supporting pan, tilt and zoom, IP 
videophones, RFID readers, point-of sale or 
wireless access points.

Secure Management
Only authorized administrators can 
access the management interface of the 
SwitchBlade x3112. Protocols such as SSH 
provide an encrypted interface for both local 
and remote connections, with out of band 
management achieved though a dedicated 
gigabit port if required.
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Key Features
Performance

»» Dual»fabric»cards»enable»load»sharing,»providing»
800Gbps»throughput.

Power over Ethernet

»» Power»over»Ethernet»Plus»provides»standards-based»
IEEE»802.at»class»4»for»up»to»80»10/100/1000T»
ports»or»IEEE»802.3af»at»class»3»for»up»to»155»
10/100/1000T»ports.

Ethernet Protection Switching Rings (EPSR) 

»» EPSR»is»a»protection»scheme»for»Ethernet»networks,»
specifically»for»ring-based»network»topologies.»EPSR»
provides»a»sub»50»milliseconds»switching»time»for»
an»Ethernet-based»ring»network,»to»maintain»Layer»
2»redundancy»in»the»network.»EPSR»assists»the»
multicast»streams»in»being»redirected»around»a»faulty»
link»in»a»ring»network»fast»enough»to»result»in»an»
uninterrupted»multicast»service.»

Spanning Tree

»» Supports»STP,»RSTP»and»MSTP.

Link Aggregation Group (LAG)

»» The»x3112»supports»a»maximum»of»127»LAGs»config-
ured»on»the»system»at»one»time.»A»maximum»of»eight»
member»ports»per»LAG»is»supported.

VLAN and Tagging 

»» Supports»4K»active»VLANs.

Upstream Forwarding Only (UFO) Mode

»» A»VLAN»can»be»created»where»all»data»on»the»VLAN»
from»downstream»ports»must»be»forwarded»only»to»
the»upstream»port.

HVLAN (Port- and VLAN-based, VLAN Double 
Tagging)
»» To»help»overcome»the»VLAN»addressing»limitation,»
an»additional»or»outer»tag»can»be»added»on»top»of»the»
802.1Q»tagged»or»untagged»frame.»The»use»of»the»
additional»tag»creates»a»hierarchical»VLAN»(HVLAN).

IGMP Snooping

»» IGMP»snooping»allows»the»product»to»conserve»
network»bandwidth»by»limiting»the»layer»2»forwarding»
of»IP»multicast»packets»only»to»the»LAN»segments»
that»have»expressed»interest»in»receiving»packets»
addressed»to»a»multicast»group.

Quality of Service (QoS)

»» Classifies»traffic»based»on»user-defined»flows»such»as»
voice,»data»or»video»services.»Supports»eight»priority»
queues.

Access Control Lists (ACLs)

»» Access»Control»Lists»enable»inspection»of»incoming»
frames»and»classify»them»based»on»various»criteria.»
Specific»actions»can»then»be»applied»to»these»frames»
in»order»to»more»effectively»manage»the»network»
traffic»at»Layer»2»through»Layer»4.»Typically»ACLs»are»
used»as»a»security»mechanism,»either»permitting»or»
denying»entry»(hence»the»name»Access»Control)»for»
frames»in»a»group,»but»can»also»be»applied»to»QoS.

Egress Port Rate Limiting

»» Supports»egress»rate»limiting»for»customer-»and»
network-facing»ports.

RADIUS/TACACS+ Authentication

»» TACACS+»and»RADIUS»authentication»operates»by»
using»an»external»server»as»a»means»to»authenticate»
logins»to»the»system.

802.1x Port Authentication

»» 802.1x»provides»port-based»network»access»control»
for»restricting»access»to»networks»based»on»authenti-
cation»information.

Secure Shell (SSHv2)

»» Provides»secure»remote»logins»into»the»command-line»
interface»(CLI).

Address Resolution Protocol (ARP) Filtering 

»» ARP»filtering»provides»the»ability»to»“authenticate”»
ARP»messages»to»ensure»that»unauthorized»ARP»
spoofing»is»not»permitted.

Simple Network Management Protocol (SNMP)

»» Supports»SNMPv1»and»SNMPv2c.

Link Layer Discovery Protocol (LLDP)

»» LLDP»is»an»application»protocol»that»runs»directly»over»
Layer»2»in»network»elements»to»facilitate»a»centrally»
located»network»manager»to»derive»the»physical»
network»topology»the»network»elements»are»part»of.

Remote Network Monitoring (RMON)

»» A»collection»of»traffic»statistics»over»port»interfaces,»
accrued»in»a»specified»time»period.

Securing the Network

»» Supports»three»levels»of»security:»User,»Manager,»and»
Security»Officer.

Secure Digital (SD) Card

»» SD»is»used»for»file»and»log»activities»after»the»system»
has»initialized.
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Product Specifications

System Capacity
AT-SBx31CFC (Controller Fabric Card)

512MB»DDR2»SDRAM
512KB»NVRAM
128MB»Flash»memory
32K»MAC»address
4K»Active»VLANs
16Mbit»packet»buffer»memory

AT-SBx31GP24 (24 x 10/100/1000T PoE+ Line 
Card)

128MB»DDR2»SDRAM
16MB»Flash»memory
16K»MAC»address
4K»Active»VLANs
12Mbit»packet»buffer»memory

AT-SBx31XZ4 (4 x 10Gbps (XFP) Line Card))
128MB»DDR2»SDRAM
16MB»Flash»memory
32K»MAC»address
4K»Active»VLANs
16Mbit»packet»buffer»memory

AT-SBx31GS24 (24 x 100/1000 SFP Line Card)
128MB»DDR2»SDRAM
16MB»Flash»memory
32K»MAC»address
4K»Active»VLANs
16Mbit»packet»buffer»memory

Maximum Bandwidth
Non-blocking»for»all»packet»sizes
Throughput:»595»Mpps
Switch»fabric:»800Gbps
Supports»10K»byte»jumbo»packets

Wirespeed Switching on all Ethernet Ports
14,880pps»for»10Mbps»Ethernet
148,800pps»for»100Mbps»Ethernet
1,488,000pps»for»1000Mbps»Ethernet

Latency

AT-SBx31GP24 Latency (64 Byte)
10Mbit 244,261»ns

100Mbit 178,949»ns

1000Mbit 137,506»ns

AT-SBx31XZ4 Latency (64 Byte)
10Gbit 34,252»ns

AT-SBx31GS24 Latency (64 Byte)
100Mbit TBD»ns

1000Mibt TBD»ns

Port Configurations
Auto-negotiation,»duplex,»MDI/MDI-X,»IEEE»802.3x»flow»

control/back»pressure
Head»of»Line»(HOL)»Blocking»Prevention

Ethernet Specifications
RFC»894»Ethernet»II»Encapsulation
IEEE»802.1D»MAC»Bridges
IEEE»802.1Q»Virtual»LANs
IEEE»802.2»Logical»Link»Control
IEEE»802.3ab»1000BASE-T
IEEE»802.3ac»VLAN»TAG
IEEE»802.3u»100BASE-T
IEEE»802.3x»Full»Duplex»Operation
IEEE»802.3z»Gigabit»Ethernet
IEEE»802.3af»Power»over»Ethernet»Class»3
IEEE»802.3at»Power»over»Ethernet»Class»4
Jumbo»Frames»(10K»Bytes)»

Spanning-Tree Protocol
IEEE»802.1D»Spanning-Tree»Protocol
IEEE»802.1w»Rapid»Spanning-Tree»Protocol
IEEE»802.1s»Multiple»Spanning-Tree»Protocol»
BPDU»Cop

Resiliency
EPSR
EPSR»SuperLoop»
Bi-Directional»Forwarding»Detection
Static»Link»Aggregation»Groups»(LAG)
Layer»2»Control»Plane»Prioritization
Hot-standby»Controller»Redundancy
System»Power»Redundancy
PoE+»Power»Redundancy*

Multicast
RFC»1112»IGMP»Snooping»v1
RFC»2236»IGMP»Snooping»v2
Dynamic»Multicast»Router»Detection
Set»Top»Box»Mobility»Control
Configurable»Unknown»Multicast»Flooding

Security
RADIUS»Client
TACACS+
User»Account»Management
SSHv2
BPDU»Protection
DHCP»Snooping
RFC»3042»DHCP»Relay
DHCP»Option»82»Insertion
Auto»IP»Filtering
ARP»Filtering
Local»ARP»Discard
Access»Control»Lists»(ACLs)
Password»Recovery

Convergence
8»QoS»Queues»Per»Port
Policy-Based»QoS»
Configurable»User»Priority-to-Queue»Mapping
Egress»Port»Rate»Limiting
Egress»Queue»Rate»Limiting
Priority»Tagging»(IEEE»802.1p»for»ingress)
Remarking
Strict»Priority»Queue»Servicing
IEEE»802.1ab»Link»Layer»Discovery»Protocol»(LLDP)

Network Manageability
CLI»Interface
Command»Line»Help
RFC»854»Telnet»Server
Telnet»Client
Out-of-band»Ethernet»/»IP»Management»Interface
In-band»Ethernet»/»IP»Management»Interface
Login»Banner
TFTP»Client
FTP»Client
RFC»1157»SNMPv1
RFC»1902-1904»SNMPv2c
Command»Scripting
Command»Aliases
Time»and»Daylight»Savings»Time»Management
SNTP
Syslog»
Log»Streaming
Log»Filtering
DNS»Client
Management»Interface»ICMP»Support

MIB Support
RFC»1213»MIB-II
RFC»1573»MIB-II
RFC»2819»RMON»MIB

Performance / Fault Management
RFC»1757»RMON»Groups»1,2,3,9
RMON»Threshold»Crossing»Alerts
User-defined»Packet»Counters
CPU»Utilization»Statistics
Alarm»Management
Configurable»Alarm»Security
Port»Outage»Alarm»Threshold
Thermal»Monitoring
Power-up»Diagnostics

Equipment Management
Profile»Management
Auto-provisioning
Pre-provisioning
PoE»Management

Layer 2 Switching / Control
FDB»Management
Configurable»MAC»Removal»Modes
Port-based»VLAN»Double»Tagging»(Q-in-Q)
TPID»Editing
MAC»Address»Learning»Limits
Protocol»Tracing
Jumbo»Frames»(Layer»2»Forwarding)»

VLAN
4K»VLANs»(802.1Q)»
VLAN»Management
Configurable»VLAN»Ingress»Check
VLAN-based»Double»Tagging»(Q-in-Q)
VLAN»Translation
Upstream»Forwarding»Only»(UFO)»VLANs
UFO»Control»Protocol»(UCP)

System Administration 
Software»Load»Management
Network»Booting
File»Management
Binary»Database»Backup»/»Restore
Text»Config»File»Backup»/»Restore

Hardware 
Redundant»Controller»/»Fabric»Card
SD»Removable»Media»supported»only»on»AT-SBx31CFC
Redundant»1200W»System»Power»Supply»Units
Load-sharing»1200W»PoE»Power»Supply»Units
Fan»Tray

RoHS Standards
Compliant»with»European»and»China»RoHS»standards

Package Description
SBx3112»chassis
Management»cable»(RJ-45»to»DB-9)
Hardware»kit»accessories
Installation»guide»and»CLI»user’s»guide»available»at»»

alliedtelesis.com/support/software

*»Depends»on»PoE»loading
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Physical Specifications
Product Dimensions (W x D x H)
AT-SBx3112»Chassis 48.03cm»x»38.79cm»x»31.01cm
AT-SBx31CFC»Fabric»Control»Card 20.67cm»x»31.32cm»x»40.64cm
AT-SBx31GP24»PoE»Line»Card 20.67cm»x»31.32cm»x»40.64cm
AT-SBx31XZ4»XFP»Line»Card 20.67cm»x»31.32cm»x»40.64cm
AT-SBx31GS24»SFP»Line»Card 20.67cm»x»31.32cm»x»40.64cm
AT-SBx3161»System»Power»Supply 10.16cm»x»32.21cm»x»4.34cm
AT-SBx3165»PoE»Power»Supply 10.16cm»x»32.21cm»x»4.34cm
AT-SBx31FAN»Tray 2.74cm»x»33.35cm»x»26.04cm»

Product Weight
Product Weight (kg / lbs)
AT-SBx3112»Chassis 17.77»kg»(39.10»lb)
AT-SBx31CFC»Fabric»Control»Card 1.09»kg»(2.40»lb)
AT-SBx31GP24»PoE»Line»Card 1.06»kg»(2.34»lb)
AT-SBx31XZ4»XFP»Line»Card 0.82»kg»(1.80»lb)
AT-SBx31GS24»SFP»Line»Card 1.06»kg»(2.34»lb)
AT-SBx3161»System»Power»Supply 2.75»kg»(6.05»lb)
AT-SBx3165»PoE»Power»Supply 2.73»kg»(6.00»lb)
AT-SBx31FAN»Tray 1.82»kg»(4.00»lb)

Power Specifications
AC»Voltage»/»Frequency»Requirements: 100-240»VAC,»50/60»Hz
AT-SBx3161 16A»maximum»@»100V
AT-SBx3165 16A»maximum»@»100V

Maximum power consumption»
AT-SBx31CFC 48.3W
AT-SBx31GP24»POE 34.4W
AT-SBx31XZ4 48.3W
AT-SBx31GS24 56.3W

Maximum power supply efficiency (based on 100W input voltage)
12V»PSU 78.4%»(100%»load)

81.8%»(50%»load)

56V»PSU 81.3%»(100%»load)
83.6%»(50%»load)

Heat dissipation
AT-SBx31CFC 164.91»BTU/hr
AT-SBx31GP24»POE 164.88»BTU/hr
AT-SBx31XZ4 117.44»BTU/hr
AT-SBx31GS24 192.21»BTU/hr

Power over Ethernet Specifications
Available»Power»over»Ethernet 1200W»@»56»VDC»(Using»one»PoE»PSU)

IEEE»802.3at»Class»4»(30W/port) Max»40»ports
IEEE»802.3af»Class»3»(15.4W/port) Max»77»ports
IEEE»802.3af»Class»2»(7.0W/port) Max»171»ports
IEEE»802.3af»Class»1»(4.0W/port) Max»240»ports

Available»Power»over»Ethernet 2400W»@»56»VDC»(Using»two»PoE»PSU)

IEEE»802.3at»Class»4»(30W/port) Max»80»ports
IEEE»802.3af»Class»3»(15.4W/port) Max»155»ports
IEEE»802.3af»Class»2»(7.0W/port) Max»240»ports
IEEE»802.3af»Class»1»(4.0W/port) Max»240»ports

IEEE»802.3at»/»IEEE»802.3af»Mode»▶»Alternative»A»(MDI)

Environmental Specifications
Operating»Temperature» -0°C»to»40°C»(32°F»to»104°F)
Storage»Temperature» -25°C»to»70°C»(-13°F»to»158°F)
Operating»Humidity» 5%»to»90%»non-condensing
Storage»Humidity» 5%»to»95%»non-condensing
Operating»Altitude»Range» Up»to»3,000m»(9,843»ft)
Acoustic»Noise» 75.7dB
Acoustic»noise»measured»at»40°C»using»the»following»products:

Product Quantity
AT-SBx3112»Chassis» 1
AT-SBx31CFC»Fabric»Control»Card» 2
AT-SBx31GP24»PoE»Line»Card» 5
AT-SBx31XZ4»XFP»Line»Card» 5
AT-SBx3161»System»Power»Supply» 2
AT-SBx3165»PoE»Power»Supply» 2
AT-SBx31FAN»Tray» 1

Safety and Electromagnetic Emissions Certifications
EMI/RFI FCC»Class»A,»EN55022»Class»A,»CISPR»Class»A
Immunity EN55024
Electrical»Safety EN60950-1»(TUV),»UL60950-1»(CULUS),»EN60825
Safety»Agency»Approvals CULUS,»TUV,»C-TICK,»CE

Quality and Reliability
Product MTBF
AT-SBx3112»Chassis 260,000
AT-SBx31CFC»Fabric»Control»Card 310,000
AT-SBx31GP24»PoE»Line»Card 300,000
AT-SBx31XZ4»XFP»Line»Card 420,000
AT-SBx31GS24 300,000
AT-SBx3161»System»Power»Supply 460,000
AT-SBx3165»PoE»Power»Supply 460,000
AT-SBx31FAN»Tray 460,000
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Ordering Information

AT-SBx3112-96POE+ 
96»port»Chassis»Bundle»
1»x»SBx3112»Chassis
1»x»SBx31CFC»Fabric»Control»Card»
4»x»SBx31GP24»PoE»line»card»
1»x»SBx3161»System»Power»Supply
1»x»SBx3165»PoE»Power»Supply»
1»x»SBx31FAN»Tray

AT-SBx3112-8XR
8»x»10G»port,»Redundant»Starter»Bundle
1»x»AT-SBx3112»Chassis
2»x»AT-SBx31CFC»Fabric»Control»Card
2»x»AT-SBx31XZ4»XFP»Ethernet»Line»Card
2»x»AT-SBx3161»System»Power»Supply
1»x»AT-SBx31FAN»Tray

AT-SBx3112
Rack»mount»12»slot»chassis»with»fan»tray

AT-SBx31CFC
Fabric»switch»controller»line»card

AT-SBx31GP24
24»port»10/100/1000Base-T»PoE»Ethernet»line»card

AT-SBx31XZ4
4»port»10GE»XFP»Ethernet»line»card

AT-SBx31GS24
24»port»SFP»Ethernet»line»card

AT-SBx3161-xx
1200W»AC»System»Power»Supply

AT-SBx3165-xx
1200W»AC»PoE»Power»Supply

AT-SBx31FAN Tray
Contains»4»fans,»temperature»sensors»and»controller»board

Where»xx»=»
10»for»US»power»cord
20»for»no»power»cord
30»for»UK»power»cord
40»for»Australian»power»cord
50»for»European»power»cord

Power»cords»are»only»shipped»with»AT-SBx3161»or»
AT-SBx3165»power»supplies.

Accessories

Small Form Pluggable Optics Supported 
Platforms

AT-XPSR XFP,»MMF,»10Gbps,»
300m,»850nm,»LC

AT-SBx31XZ4

AT-XPLR XFP,»SMF,»10Gbps,»
10km,»1310nm,»LC

AT-SBx31XZ4

AT-XPER40 XFP,»SMF,»10Gbps,»
40km,»1550nm,»LC

AT-SBx31XZ4

AT-XPER80 XFP,»SMF,»10Gbps,»
80km,»1550nm,»LC

AT-SBx31XZ4

AT-SPSX SFP,»MMF,»1000Mbps,»
220»/»500m,»850nm,»
LC

AT-SBx31GS24

AT-SPEX SFP,»MMF,»1000Mbps,»
2km,»1310nm,»LC

AT-SBx31GS24

AT-SPLX10 SFP,»SMF,»1000Mbps,»
10km,»1310nm,»LC

AT-SBx31GS24

AT-SPLX40 SFP,»SMF,»1000Mbps,»
40km,»1310nm,»LC

AT-SBx31GS24

AT-SPZX80 SFP,»SMF,»1000Mbps,»
80km,»1550nm,»LC

AT-SBx31GS24

AT-SPBD10-13 SFP,»SMF,»1000Mbps,»
10km,»1310/1490nm,»
LC-BiDi

AT-SBx31GS24

AT-SPBD10-14 SFP,»SMF,»1000Mbps,»
10km,»1490/1310nm,»
LC-BiDi

AT-SBx31GS24

AT-SPFX/2 SFP,»MMF,»100Mbps,»
2km,»1310nm,»LC

AT-SBx31GS24

AT-SPFXBD-
LC-13

SFP,»SMF,»100Mbps,»
10km,»1310/1510nm,»
LC-BiDi

AT-SBx31GS24

AT-SPFXBD-
LC-15

SFP,»SMF,»100Mbps,»
10km,»1510/1310nm,»
LC-BiDi

AT-SBx31GS24

AT-SPFX/15 SFP,»SMF,»100Mbps,»
15km,»1310nm,»LC

AT-SBx31GS24

617-000374

SwitchBlade x3112 | Access Edge Chassis Switch


